Report Builder
User’s Guide
# Table of Contents

**Foreword**  
0

## Part I Report Builder

### 1 Overview
4

### 2 How To
7
- Template Files .................................................................................................................. 7
- Add Fields .......................................................................................................................... 8
- Receive Filters .................................................................................................................. 10
- Adjust Search ................................................................................................................... 11
- More Help ........................................................................................................................ 12

### 3 Workspaces
13
- About the Report Designer ............................................................................................ 13
- Data Workspace ............................................................................................................... 13
- Design Workspace ......................................................................................................... 14
- Preview Workspace ........................................................................................................ 15

### 4 Data-Specific Tools
16
- Database .......................................................................................................................... 16
- DataView .......................................................................................................................... 17
- Data pipeline .................................................................................................................... 18
- SQL ....................................................................................................................................... 18
- Query Wizard .................................................................................................................. 18
- Query Designer ............................................................................................................... 22

### 5 Report-Building Tools
26
- About report-building tools .......................................................................................... 26
- Report Wizard ................................................................................................................... 27
- Label Template Wizard ................................................................................................... 33
- CrossTab Wizard ............................................................................................................. 34

### 6 Toolbars
35
- About toolbars .................................................................................................................. 35
- Advanced Component Palette ......................................................................................... 35
- Align or Space Toolbar ..................................................................................................... 36
- Data Component Palette ................................................................................................. 36
- Data Tree .......................................................................................................................... 36
- Draw Toolbar .................................................................................................................... 37
- Standard Toolbar ............................................................................................................. 37
- Edit Toolbar ....................................................................................................................... 38
- Format Toolbar ................................................................................................................ 39
- Nudge Toolbar .................................................................................................................. 39
- Report Tree ....................................................................................................................... 39
- Standard Component Palette ......................................................................................... 40

### 7 Bands
40
- About Bands ..................................................................................................................... 40
- Header ............................................................................................................................... 41
- Group .................................................................................................................................. 42
- Group Header .................................................................................................................. 42
- Detail ................................................................................................................................... 43
- Footer ................................................................................................................................ 44

---

*Copyright ©*
## Contents

| Group Footer                                                                 | 44 |
| Summary                                                                      | 45 |
| Title                                                                        | 46 |
| **8 Components**                                                            | 46 |
| Advanced                                                                    | 46 |
| CrossTab                                                                    | 46 |
| Region                                                                      | 46 |
| SubReport                                                                   | 47 |
| Standard                                                                    | 47 |
| BarCode                                                                    | 47 |
| Checkbox                                                                   | 47 |
| Image                                                                       | 47 |
| Label                                                                       | 47 |
| Line                                                                        | 47 |
| Memo                                                                        | 47 |
| RichText                                                                    | 48 |
| System Variable                                                             | 48 |
| Shape                                                                       | 48 |
| Variable                                                                    | 48 |
| Data-aware                                                                  | 48 |
| DBBarcode                                                                   | 48 |
| DBCalc                                                                      | 49 |
| DBCheckBox                                                                  | 49 |
| DBImage                                                                     | 49 |
| DBMemo                                                                      | 49 |
| DBRichText                                                                  | 49 |
| DBText                                                                      | 49 |
| Speed Menu Options                                                          | 50 |
| AutoSize                                                                    | 50 |
| Bring to Front                                                              | 50 |
| Configure                                                                   | 50 |
| DisplayFormat                                                               | 50 |
| Edit                                                                        | 50 |
| Lines                                                                       | 50 |
| MailMerge                                                                   | 50 |
| MaintainAspectRatio                                                         | 51 |
| Pagination                                                                  | 51 |
| ParentHeight                                                                | 51 |
| ParentWidth                                                                 | 51 |
| Position                                                                    | 51 |
| ReprintOnOverFlow                                                           | 51 |
| Send to Back                                                                | 51 |
| ShiftRelativeTo                                                             | 52 |
| StretchWithParent                                                           | 52 |
| StretchWithParent                                                           | 52 |
| Stretch                                                                     | 52 |
| Style                                                                       | 52 |
| SuppressRepeatedValues                                                      | 52 |
| Visible                                                                     | 52 |
| **Static VS. Stretchable**                                                  | 53 |
| Stretchable                                                                 | 53 |
| Static                                                                      | 53 |
| **9 Reference**                                                             | 54 |
1 Report Builder

INTRODUCTION- REPORT BUILDER

ExpressMaintenance includes an extremely powerful built-in Report Builder. Report Builder unleashes your data to be reported and exported virtually any way you can imagine.

Report Builder is developed by Digital Metaphors Corporation and offers ExpressMaintenance users the maximum in data reporting flexibility. This help section was designed by Digital Metaphors Corporation and is made available through the ExpressMaintenance help system.

Designing custom reports does require some familiarity with database concepts. Using the report builder is an easy process but may take a little practice. We recommend you start with simple list reports and then work up to more complicated reports.

You will find this help to covers the Report Builder features and tools. However, it does not address the concepts of data structures. Most of the data will be self explanatory since it is your maintenance data. Additional help is available.

For additional help:
- Do not contact Digital Metaphors directly as they do not provide end user tech support.
- Visit the Report Builder site to learn more about Report Builder at: http://digital-metaphors.com/
- Consult this help file completely and practice with simple reports.
- Download, install the Report Builder Learning System provided by Digital Metaphors and available from our website at: http://www.expresstechnology.com/DownloadTrial.htm
- Contact Express Technology tech support via email for specific help at: support@ExpressTechnology.com

1.1 Overview

OVERVIEW

In an overview to ReportBuilder, the reporting equation is described. The reporting equation divides reporting into four main activities:

With ReportBuilder Pro, you get a complete set of components that enable end-users to perform the data access, report layout, and report output activities of the reporting equation. This goal is achieved by delivering visual, easy-to-use solutions. This screen shot of the ReportBuilder Pro Report Designer shows the ergonomic design of the user-interface.

Data

Within the work environment of the Data tab, end users can quickly create dataviews, which can then be used to supply data to reports. Dataviews are usually created via the Query Wizard or Query Designer. Both of these tools are visual; they also allow the end-user to select the tables, fields, search criteria, and sort order necessary for the report. Behind the scenes, an SQL statement is generated and used to retrieve the data from the database. A screen shot of a
completed dataview is shown below.

![ReportBuilder: Parts List By Vendor](image)

The solution described above is the standard behavior within the data workspace. However, the developer can customize this user-interface by doing one of three tasks:

- Register a replacement query wizard or query designer.
- Remove the query wizard or query designer.
- Create new dataview template classes that can simplify the data selection process even further by establishing the relationship between the tables in the database and presenting an alternative user-interface (such as a single form that allows search/sort criteria to be entered).

The bottom-line is that the Data area contains a turnkey solution that can be used out-of-the-box, but if customizations are needed, an architecture has been provided so that those customizations are possible.

**Design**

The Design workspace contains the actual layout of the report. The user-interface is identical to the one presented to developers using ReportBuilder at Delphi design-time; in other words, it is full-featured and professional. The Office97 interface-style makes the Design workspace especially easy to learn for end users. A Report Wizard is available for creating reports quickly. You can customize this interface by replacing any of the dialogs it uses and by registering your own report wizards.
Preview
The Preview workspace contains the rendered report. The report can be printed to the printer or to various file formats from this workspace.
1.2 How To

HOW TO ...

Below are common questions presented by users concerning the use of the Report Builder:

- **How do I import / export report templates into the application?**
- **How do I add fields or adjust the layout of a report?**
- **How can I make my report receive filters from ExpressMaintenence?**
- **How to make a report include all of the data records I expect?**
- **How can I get comprehensive help or a tutorial on Report Builder?**

You can download original report definitions for all reports - [click here for list](#).

1.2.1 Template Files

**How do I import / export report templates into the application?**

All Express Technology applications have a feature that allows users to import and export report formats to report template files. Exporting a report to file is very helpful if you want to save a report.
template to a text (.rtm, .rdf*, .ini or .txt) file before making alterations. Or, you might want to export a report template to a text file and email it to our support staff.

Occasionally, our support staff may make a custom alteration to a report and email it to you for importing. Or, you may want to import one of the original report formats.

The text file produced by exporting reports contains the report template / layout. It does not contain data but rather the report setup. The following is a brief description of how to import and export report formats. Do not confuse this with exporting data resulting from a report.

Caution: If you have customized the standard reports in ExpressMaintenance, importing a report template file will overwrite your existing reports. You should save any customized reports to a new name before importing report template files.

**Exporting Report Template (Formats)**

1. Run the application such as ExpressMaintenance.
2. Open the applicable report screen. Example: Maintenance / Reports.
3. Locate the desired report in the list of reports in the right panel.
4. Right click on the report and the popup menu will appear.
5. Left click on the "Export Select Report to File" option.
6. Select the desired destination folder where the report will be exported using the report name with the .rtm (or .rdf*) extension.
7. Email the .rtm file as an attachment or keep it as a backup.

**Importing Report Template Files (Formats)**

1. Locate the desired report template file and download - click here for list. Note: Some browsers require that you right click on the desired file in order to download.
2. Or, if emailed, save the report (.rtm) file to disk, noting the folder where the file is saved.
3. Run the application such as ExpressMaintenance.
5. Right click on any report and the popup menu will appear.
6. Left click on the "Import Report(s) from File" option.
7. Use the windows dialog box to locate the report template (.rtm) file.
8. Click the Open button to open the file.
9. The report will be imported and a dialog will reflect the completion.

*Note: The file types for some applications which use the Shazam Report Designer is *.rdf (report definition file). Applications are being converted to the Report Builder which use *.rtm files.

You can download original report definitions for all reports - [click here for list](#).

### 1.2.2 Add Fields

**How do I add fields or adjust the layout of a report?**

ExpressMaintenance includes a very powerful built-in report builder. All of the standard reports included with ExpressMaintenance are built using the report builder. It is often desirable to adjust reports to include or exclude certain fields. While you can develop new reports from scratch, it is usually easiest to edit an existing report that is close to the desired results.

This example will show how to alter a simple report. It provides some introductory concepts of using the report builder. More advance uses of the report builder are certainly possible. However, it is best to have some knowledge of database and report design concepts.

You should make sure your toolbars are Turned-On in the Report Builder. You can do this under View / Toolbars. We recommend turning everything but Data Tree and Data Tree. You can also arrange the
tool bars by dragging them around in the window.

The report used in this example is the Units List By Location report. We will add the Unit number field to the report. Adding a field to a report involves two primary steps. All reports are made up of two building blocks which produce the report that is previewed and printed. These include:

1. Query to extract the desired data
2. Layout / design presentation of the data

First, the field must be included in the query (search) and be included as part of the returned results. Secondly, the data field must be included in the report design to appear on the report.

**Add Data Field To The Query**

1. Run the Unit List By Location report to preview on the screen.
2. Click on the Data tab of the report builder.
3. The Units table will appear as a box in the upper left portion of the screen.
4. The Units window includes several buttons that make up the Query Designer.
5. Click on the Fields button to open the Query Designer to the Fields tab.
6. The upper section reflects the available fields and lower section reflects selected fields.
7. Add the "Unit" (for example) field to the report query by locating the "Unit" field in the upper section and double click on it. This adds the Unit field to the bottom portion of the screen.
8. Edit the query filter criteria using the operator and value desired. When using Between, separate values with a comma.
9. Check AutoSearch to make the query dynamic, meaning it can be changed each time the report is executed. Check mandatory to require the filter each time.
10. Click the Ok button to save the changes in the Query Designer.
12. You can view the raw query results by clicking on the Preview button in the Units window.
13. To learn more about the Query Designer, review the help under Report Builder.

**Add Field To The Layout**

1. Click on the Design tab of the report designer.
2. Locate the Data Components toolbar which is on the top row by default. The first button appears to have an "A" in front of a table. When pointing at the button, the popup hint reads "DBText". This component is for displaying standard data fields. If adding a memo field, you will want to use the DBRichText component follow these steps plus notes below.
3. Click the DBText button and then click in the Detail band of the report layout. A DBText component will be place in that location.
4. Click the Place tab in the Page Designer dialog.
5. Size and adjust the DBText component as desired.
6. Left click on the DBText component and then look in the upper section to locate the table Data Pipeline and Data Field drop down selection fields.
7. Select the Units Data Pipeline if not already selected.
8. For the Data Field, drop down the list and select the desired field such as Unit. This associates the DBText component with the Unit number field.
9. Click the Preview to view the results.
10. To add a label for the Unit field, click on the Label component and place it in the header band. In the upper section, edit the caption of the label to read "Unit Number" or other desired value.
11. Click the Preview tab to view the results.
12. On exit of the report, save your changes.

**Other Notes**

1. If you are placing a notes field in the report, use a DBRichText component rather than a DBText component. You will also need to set the band to dynamic height and the component to stretch.
2. If you are placing a graphic field in the report, use a DBImage component rather than a DBText component. You will also need to set the band to dynamic height and the component to stretch.
3. For more comprehensive help on the report builder, view the help or other Tech Bulletins.

You can download original report definitions for all reports - click here for list.

1.2.3 Receive Filters

**How can I make my report receive filters from ExpressMaintenance?**

When a report is run in ExpressMaintenance, it first clears all filters in the report unless they are marked as mandatory. Next, the program checks the filters selected in the report filters panel (example: Type or Category). For each filter that contains a value other than "<All>" or "All", the program attempts to pass the filter to the report. If filtering is successful, ExpressMaintenance also populates the "Params" text field in the report if it exist.

You should make sure your toolbars are Turned-On in the Report Builder. You can do this under View / Toolbars. We recommend turning everything but Data Tree and Data Tree. You can also arrange the tool bars by dragging them around in the window.

The program can only pass filters to fields that exist in the tables being used in the Data tab of the report. The field does not have to be in the query result set but it does have to be part of the table. In order for the filter to be applied, the corresponding field name must exist in the table(s) that are in the query but does not have to be used in the Layout.

To view the available field in a query, follow these steps:

1. Run the Unit List By Location report to preview on the screen.
2. Click on the Data tab of the report builder.
3. The Units table will appear as a box in the upper left portion of the screen.
4. The Units window includes several buttons that make up the Query Designer.
5. Click on the Fields button to open the Query Designer to the Fields tab.
6. The upper section reflects the available fields and lower section reflects selected fields.
7. Add the "Unit" (for example) field to the report query by locating the "Unit" field in the upper section and double click on it. This adds the Unit field to the bottom portion of the screen.
8. Edit the query filter criteria using the operator and value desired. When using Between, separate values with a comma.
9. Check AutoSearch to make the query dynamic, meaning it can be changed each time the report is executed. Check mandatory to require the filter each time.
10. Click the Ok button to save the changes in the Query Designer.
11. You can view the raw query results by clicking on the Preview button in the Units window.
12. To learn more about the Query Designer, review the help under Report Builder.

The Maintenance / Reports Screen passes filters to the following field names:

<table>
<thead>
<tr>
<th>Screen Prompt</th>
<th>Table</th>
<th>Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed Date</td>
<td>WoMaster</td>
<td>CompletedDate</td>
</tr>
<tr>
<td>Scheduled Date</td>
<td>WoMaster</td>
<td>ScheduledDate</td>
</tr>
<tr>
<td>Performed Date</td>
<td>Servhist</td>
<td>Performed</td>
</tr>
<tr>
<td>Downtime Date</td>
<td>Downtime</td>
<td>DateDown</td>
</tr>
<tr>
<td>Unit Name</td>
<td>Units</td>
<td>Name</td>
</tr>
<tr>
<td>Unit Number</td>
<td>Units</td>
<td>Unit</td>
</tr>
<tr>
<td>Site</td>
<td>Units / WoMaster</td>
<td>Site</td>
</tr>
<tr>
<td>Locations</td>
<td>Units</td>
<td>Location</td>
</tr>
<tr>
<td>Unit Type</td>
<td>Units</td>
<td>Type</td>
</tr>
<tr>
<td>Unit Category</td>
<td>Units</td>
<td>CategoryID</td>
</tr>
<tr>
<td>Part Description</td>
<td>Parts / WoDetail</td>
<td>Description</td>
</tr>
</tbody>
</table>
You can apply your own filters after the report is executed and being viewed. Simply go to the Data tab and click on the Search button. Double click on the desired field and edit the search criteria with the desired operator and value. You can make a filter permanent by selecting the mandatory option.

You can download original report definitions for all reports - click here for list.

1.2.4 Adjust Search

How to make a report include all of the data records I expect?

You should make sure your toolbars are Turned-On in the Report Builder. You can do this under View / Toolbars. We recommend turning everything but Data Tree and Data Tree. You can also arrange the toolbars by dragging them around in the window.

When a report is empty or does not include the expected data, this meaning it shows limited or no records found. This a direct result of the query being applied to search for the data. The query statement is comprised of the search filters that are entered in the Query under the Data tab of the Report Builder.

How can I check the data query?

1. Click on the Data tab of the report builder
2. The query will appear in a window in the upper left section of the screen
3. Locate and click on the Search button (magnify glass)
4. The Query Designer will appear with the Search tab selected
5. Examine the lower section of the screen for the search criteria being applied
6. Adjust the search criteria as desired to get the desired data result set
7. Edit the query filter criteria using the operator and value desired. When using Between, separate values with a comma.
8. Check AutoSearch to make the query dynamic, meaning it can be changed each time the report is executed. Check mandatory to require the filter each time.
9. To make a query filter permanent, click on the mandatory checkbox. To make it permanent and not to be auto overwritten from the program, un-check AutoSearch.
10. Click Ok to save the changes.
11. In the Data tab and query table window, click the Preview button to see the raw data results of the query.

How do I correct a report with this problem?

1. One option is to edit the filter as outlined above
2. Another option is to import the original report template by downloading from website page - click here for list. The page also includes a link on instructions for importing report template files.

What if the program does not allow me to edit reports?
You must have permission to make report changes in order to adjust the report. If you do not have permission, see your system administrator for assistance.

You can download original report definitions for all reports - click here for list.
### More Help

**How can I get comprehensive help or a tutorial on Report Builder?**

ExpressMaintenance and other products developed by Express Technology include the very powerful Report Builder. The report builder is a third party component that we compile directly into the ExpressMaintenance. It provides a very flexible query/reporting tool that allows you full access to your data with virtually unlimited presentation capabilities.

Report Builder is very easy to use. However, using any report designer does take some time and practice to become efficient. Three additional help tools are available to enhance your use and understanding of the report builder. These include help files on the report builder and SQL as well as a tutorial on the Report Builder.

**Report Builder Help System & Manual**

The Report Builder help file is automatically included in the ExpressMaintenance application help. Check the chapter titled "Report Builder". The help file is also available as an Adobe pdf file. [Click here to download report builder help in pdf manual format.](#)

**Complete Learning Report Builder Tutorial**

Learning Report Builder is a complete learning system designed to teach end users how to build a range of reports. This system includes a 125-page PDF file, a stand-alone application complete with database, and help file. The PDF file is comprised of a series of tutorials that step end users through the process of building reports as simple as a table listing and as complex as crosstabs. The tutorials introduce conceptual aspects of report building along the way. The application is used in conjunction with the tutorials so the learning experience is interactive. Users print out the PDF file, run the application, and learn Report Builder. The help file is accessible from the application, so all three tools work together to provide a seamless learning environment.

Learning Report Builder installs into C:\ProgramFiles\LearnReportBuilder. When the system has successfully installed, a complete set of instructions appears in the form of a ‘ReadMe’ doc, so the end user knows what to do next. [Click here to download the Learning Report Builder tutorial.](#)

The Learning Report Builder PDF is also available as a bound book. For ordering directly from Digital-Metaphors, visit: [https://www.digital-metaphors.com/secure/orderform.html](https://www.digital-metaphors.com/secure/orderform.html)

**SQL Help & Concepts**

It is important to understand that the report designer is simply a graphical interface for building SQL queries. Therefore, a better understanding of SQL and the Select statement will provide an enhanced understanding of how to query the data for reporting purposes. [Click here to download SQL Books Online.](#)

Because Express Technology software is based on the Microsoft SQL Server database engine, other reporting tools can be used as well. Included are such items as Microsoft Access and Crystal Reports.

You can download original report definitions for all reports - [click here for list.](#)
1.3 Workspaces

1.3.1 About the Report Designer

Report Designer

The Report Designer is the environment in which reports are built. The Report Designer is comprised of the following three workspaces, which are accessible by tabs bearing their name:

Data  
Design  
Preview

1.3.2 Data Workspace

Data Workspace

The data workspace is where you go to set the data for a report. Query-building tools such as the Query Wizard and the Query Designer are accessible from this screen.
1.3.3 Design Workspace

Design Workspace

The design workspace is where you lay out reports. After a new report is created and data is set up in the data workspace, access the design workspace to build a report.

You should make sure your toolbars are Turned-On in the Report Builder. You can do this under View / Toolbars. We recommend turning everything but Data Tree and Data Tree. You can also arrange the tool bars by dragging them around in the window.
1.3.4 Preview Workspace

The preview workspace is used to see the printed layout of a report. This workspace is especially useful when building a report. Place a component in band in the design workspace, then preview to see where it prints and how it looks. Click the tab at the top of the Report Designer marked Preview in order to access this screen. It's a good idea to save the report before selecting the preview tab, as the report generates upon preview.
A database is a holding tank for data, or raw facts and figures. Databases are comprised of tables, which are collections of data organized into columns and rows, or fields. A report cannot be created without a database.
The DataView appears upon the completion of a query. It allows you to make changes to the existing query. When you complete a query, the DataView is displayed in the left corner of the data workspace. Here's an example of a DataView. Place your cursor over the icons to learn more about them.
1.4.3 Data pipeline

Data Pipeline

Data pipelines represent a database table or SQL query and provide a set of data structured as records and fields. All data-aware components need to be assigned to a data pipeline.

1.4.4 SQL

SQL

SQL stands for Structured Query Language. It's a language used to access data from a database. You can create SQL queries without knowing the language via the Query Wizard or the Query Designer. You cannot build a report without accessing data from a database.

1.4.5 Query Wizard

Query Wizard

The Query Wizard is a tool that helps you choose the data you want to use for a report. As you select this data, the Query Wizard builds an SQL statement, which allows you to select data from a database. When you complete a query via the Query Wizard, a DataView is displayed. You can go back into a query and make changes via the DataView. When you re-enter a query, you do so by using the Query Designer. Click the Data tab and select File | New in order to access the Query Wizard.

Select the Table(s) for the query.
Select the fields for the query

Available Tables:
- Parts.BillingPrice
- Parts.CategoryID
- Parts.Notes
- Parts.QuantityOnHand
- Parts.RecordNumber
- Parts.ReplacePart
- Parts.Shelf
- Parts.Site
- Parts.StartupQuantity
- Parts.Status
- Parts.Type

Available Views:
- Description
- Location
- Manufacturer
- Numbered
- Vendor
- CurrentCost
- ManufacturerNumber
- MinimumOnHand
- Picture

---

Copyright ©
Select the order of the resulting query

Add any calculated or concatenated fields
Add any grouping to only show totals or sums
Complete and generate the query. Can be edited with the query designer.

1.4.6  **Query Designer**

**Query Designer**

The Query Designer is a tool that allows you to select data from a database without using SQL. When you complete a query, a DataView is displayed. Click the Data tab and select File | New in order to access the Query Designer.

Select table(s) to be used in the query
Select fields to be in the query

Create any calculated fields
Define any grouping fields for total or summary reports

Define any search criteria for the query
Define the sort order for the query results

View the resulting SQL statement
1.5 Report-Building Tools

1.5.1 About report-building tools

Report-Building Tools

The Report Designer offers three tools that generate reports for you based on the selections you make when working with them. These tools, or wizards, are available in the design workspace. Select File | New, then click on the icon to access a wizard.
1.5.2 Report Wizard

Report Wizard

The Report Wizard is a tool in the design workspace that allows you to create a report by answering some questions pertaining to data, layout, and style. Access this tool by selecting File | New, then clicking the Report Wizard icon.

Select Field To Be Included
Report Builder

Which fields do you want on your report?

Data Pipeline Name
Parts

Available Fields
- QuantityOnHand
- MinimumOnHand
- Shelf
- Site
- Status
- Type
- VendorNumber
- CategoryID

Selected Fields
- Description
- Location
- Manufacturer
- Numbered
- Vendor

Order

Define Group If Desired
Select Grouping Orientation
Report Wizard

Orientation

Customers

COMPANY REGION CITY STATE
Action Club
Southwest
Sarasota FL
Tampa FL
Southwest
San Jose CA
Phoenix AZ
South
Dallas TX
Atlanta GA
Charlotte NC

Layout
- Stepped
- Block
- Outline 1
- Outline 2
- Align Left 1
- Align Left 2

Orientation
- Portrait
- Landscape

☑ Adjust field widths so all fields fit on page.

Select Report Style

Cancel  < Back  Next >  Finish
Report Wizard

What style would you like?

Customers

Company
Action Club

Bold
Casual
Compact
List-style
Formal
Soft Gray

Finish The Report
Report Builder Creates the Report which you can then edit and adjust.
1.5.3 Label Template Wizard

The Label Template Wizard is a tool in the design workspace that allows you to build templates by selecting printer information and choosing a label type. Select File | New in order to access this tool.
1.5.4 **CrossTab Wizard**

The CrossTab Wizard is a tool in the design workspace that generates a report based upon the choices you make in the wizard. You can further configure the crosstab component by right-clicking and selecting Configure. Access this tool by selecting File | New, then clicking the CrossTab Wizard icon.
1.6 Toolbars

1.6.1 About toolbars

About toolbars

The design workspace has several toolbars that are used in order to create, adjust, or modify components. Toolbars can be launched by selecting View | Toolbars.

You should make sure your toolbars are Turned-On in the Report Builder. You can do this under View / Toolbars. We recommend turning everything but Data Tree and Data Tree. You can also arrange the tool bars by dragging them around in the window.

1.6.2 Advanced Component Palette

Advanced Component Palette

The Advanced component palette contains components that can help you tackle complex reporting requirements. Place your cursor over the icons to learn about the components.
1.6.3  Align or Space Toolbar

Align or Space Toolbar

This toolbar is useful when components need to be positioned uniformly. For example, it can align several components so that the tops are all even, or it can space components so that they have an equal amount of space between them. The first component selected determines the position to which the others will align.

1.6.4  Data Component Palette

Data Component Palette

This palette offers several components that are similar to components in the standard palette, except for one thing: they are data-aware. Data-aware components can read the value of a database field. Associate a data-aware component with a given table and field in the database by selecting the data pipeline and the data field from the drop-down lists in the Edit toolbar. Place your cursor over the icons to learn about the components.

1.6.5  Data Tree

Data Tree

The Data Tree can be used to create data-aware components within a band. Simply select a set of fields and drag the selection into the band. A set of corresponding data-aware components will be created. This tool window is dockable only on the left and right sides of the design workspace.
1.6.6 Draw Toolbar

Draw Toolbar

This toolbar is used to set the color and style for the shape, line, and region components.

1.6.7 Standard Toolbar

Standard Toolbar

The Standard toolbar allows you to perform basic functions such as opening, saving, and printing reports, as well as cutting and pasting selections.
1.6.8 Edit Toolbar

Edit Toolbar

This toolbar changes according to the component that is selected. Place your cursor over the fields to learn more about them.

Edit toolbar with a data-aware component

This configuration allows the data pipeline and data field for the component to be set. The drop-down list on the left shows the data pipelines. The drop-down list on the right shows the field names.

Edit toolbar with a label component

This configuration allows you to type the text for a label.

Edit toolbar with a shape component

The Edit toolbar allows you to choose from several shapes when a shape component is selected.

Edit toolbar with a line component

This configuration allows you to move the line to the top, bottom, left, or right within a line component.
1.6.9  Format Toolbar

**Format Toolbar**

This toolbar sets the font and colors of text-based components. It also sets the layering of all components.

![Format Toolbar Image]

1.6.10  Nudge Toolbar

**Nudge Toolbar**

This toolbar is useful when you want to move a component or selection of components with extreme precision. Each icon represents the direction the selection will move. Selections will move one pixel each time you press an arrow key.

![Nudge Toolbar Image]

1.6.11  Report Tree

**Report Tree**

The Report Tree can be used to view the components within each band. Components selected in the Report Tree become the selection in the report layout. You can select multiple components by holding down the Ctrl key and clicking on each name. You can rename components by right-clicking over the name, selecting Rename, and then typing in a new name. Make sure to hit the Enter key after renaming to ensure that the new name is assigned. This tool window is dockable only on the left and right sides of the design workspace.
1.6.12 Standard Component Palette

The icons on the Standard component palette represent components that are frequently used to build reports. To create a component, click on an icon and then click in a band. Place your cursor over the icons to learn about the components.

1.7 Bands

1.7.1 About Bands

A band is a section of the design workspace that describes how parts of the report will look. Bands are labeled in the section divider immediately below them; thus, the first band is called the 'header', the second is called the 'detail', and the third is called the 'footer.' The header, detail, and footer bands appear in this order as part of the layout of a newly-created report.
1.7.2 Header

Header Band

The header band prints at the top of each page. You can remove a header band from the layout by selecting Report, then clicking on Header.
1.7.3 Group

A group is a section of a report that contains a group header, detail, and group footer band. Groups are assigned to a database field. Select Report | Groups to access the groups dialog. If you want the groups to print on separate pages, select the Keep group together option in the groups dialog.

1.7.4 Group Header

Group Header Band

The group header band contains the header for a group. The components in a group header band appear at the beginning of a group. Select Report | Groups to create a group header and footer band.
1.7.5 Detail

Detail Band

The detail band prints once for every row of data.
1.7.6 Footer

Footer Band

The footer band prints its components (usually System Variables) on the bottom of each page. To remove this band from the layout, select Report, then click on Footer.

1.7.7 Group Footer

Group Footer Band

The group footer band contains the footer for a group. The components in this band print at the end of each group; therefore, if there are several groups per page, the contents of this band will print several times. Select Report | Groups to create a group footer and header band.
1.7.8 Summary

Summary Band

The summary band prints once at the end of a report. The band is typically used to summarize data. Select Report | Summary to create this band.
1.7.9 Title

Title Band

The title band contains the title of the report. It prints on the first page only. Select Report | Title to create this band.

1.8 Components

1.8.1 Advanced

1.8.1.1 CrossTab

CrossTab

The CrossTab is a component on the Advanced component palette that allows you to generate a set of calculations that summarize the data from a database table. It displays the calculations in a grid format. Right-click over the component and select Configure to set up the crosstab.

1.8.1.2 Region

Region

A region is a component on the Advanced component palette that can contain other components. To print a region after a text-printing component (memo, DBMemo, RichText, DBRichText), right-click and select ShiftRelativeTo.
1.8.1.3 SubReport

SubReport
The SubReport is a component on the Advanced component palette that allows you to create a report within a report in order to show more levels of detail or to print several reports as one.

1.8.2 Standard

1.8.2.1 BarCode

BarCode
BarCode is a component in the Standard component palette that renders barcodes. Use the Edit toolbar to set the data to be encoded. Right-click and access Configure to pick bar code types.

1.8.2.2 Checkbox

Checkbox
Checkbox is a component in the Standard component palette that renders checkboxes based yes / no or true / false values. Use the Edit toolbar to set the data to be reflected. Right-click and access the Checked property.

1.8.2.3 Image

Image
Image is a component on the Standard component palette that displays graphics (such as bitmaps, GIFs, and JPEGs). Right-click over the component and select MaintainAspectRatio to scale an image so that it is the same height and width.

1.8.2.4 Label

Label
A label is a component in the Standard component palette that functions as a header for another kind of component, such as a DBText. Use the Edit toolbar to type text into the label.

1.8.2.5 Line

Line
A line is a component in the Standard component palette that displays a line. Use the Edit toolbar to set the line orientation.
1.8.2.6  Memo

Memo
A memo is a component on the Standard component palette that allows you to load multiple lines of plain text into it. Right-click over the memo component and select Lines, then click the Load option to bring text into a memo. To print a memo after another text-printing component (DBMemo, RichText, DBRichText), right-click and select ShiftRelativeTo.

1.8.2.7  RichText

RichText
RichText is a component in the Standard component palette that prints formatted text. Right-click over the component and select MailMerge to bring a file into the component. To print a RichText after another text-printing component (memo, DBMemo, DBRichText), right-click and select ShiftRelativeTo.

1.8.2.8  System Variable

System Variable
The System Variable is a component on the Standard component palette that displays common report information such as the page number, time, and date.

1.8.2.9  Shape

Shape
A shape is a component in the Standard component palette that displays various shapes, such as squares, rectangles, circles, and ellipses. Use the Edit toolbar to change the shape type.

1.8.2.10  Variable

Variable
A variable is a component in the Standard component palette that performs calculations.

1.8.3  Data-aware

1.8.3.1  DBBarCode

DBBarCode
The DBBarCode is a component on the Data component palette that converts the data from a database field into a barcode symbol.
1.8.3.2 DBCalc

**DBCalc**
The DBCalc is a component on the Data component palette that performs simple database calculations (Sum, Min, Max, Average, Count).

1.8.3.3 DBCheckBox

**DBCheckBox**
The DBCheckbox is a component on the Data component palette that performs a display of a checked or unchecked box depending on data value. Data must be of a True / False or Yes / No (one of two values) to function properly in a checkbox. Right click on the placed component to set the properties.

1.8.3.4 DBImage

**DBImage**
The DBImage is a component on the Data component palette that prints graphics (Bitmaps, GIFs, JPEGs) that are stored in a database field. Right-click over the component and select MaintainAspectRatio to scale an image so that it is the same height and width.

1.8.3.5 DBMemo

**DBMemo**
The DBMemo is a component on the Data component palette that prints plain text from a memo field of a database table. It will automatically word-wrap the text. Select the DBMemo, then select a text-based field from the Edit toolbar to fill a DBMemo with text. To print a DBMemo after another text-printing component (memo, RichText, DBRichText), right-click and select ShiftRelativeTo.

1.8.3.6 DBRichText

**DBRichText**
The DBRichText is a component on the Data component palette that prints formatted text from a memo field. It will automatically word-wrap the text. To print a DBRichText after another text-printing component (memo, DBMemo, RichText), right-click and select ShiftRelativeTo.

1.8.3.7 DBText

**DBText**
The DBText displays data from most types of database fields. It cannot handle images or Rich Text.
1.8.4 Speed Menu Options

1.8.4.1 AutoSize

AutoSize

AutoSize is a speed menu option available for text components. When AutoSize is set to true, the component adjusts its width so that all of the text is displayed.

1.8.4.2 Bring to Front

Bring To Front

Bring to Front allows you to move an object in front of other objects. Use this option to control the appearance of overlapping objects.

1.8.4.3 Configure

Configure

Configure is a speed menu option for the Crosstab component. It allows you to access the Crosstab Designer.

1.8.4.4 DisplayFormat

DisplayFormat

DisplayFormat is a speed menu option available for textual components. This option allows you to display a value in a certain format (decimals with a dollar sign, for example). Right-click over a textual component to access the Display Format.

1.8.4.5 Edit

Edit

Edit is a speed menu option for a Rich Text component that opens a dialog which allows you to open a file and format text.

1.8.4.6 Lines

Lines

This memo speed menu option that allows you to access the Memo Editor, from which you can open text only files.

1.8.4.7 MailMerge

MailMerge

MailMerge appears when you right-click over a Rich Text component. It allows you to import field values into the Rich Text component.
1.8.4.8 MaintainAspectRatio

MaintainAspectRatio

MaintainAspectRatio is a speed menu option available for images. It scales an image so that the height and width are adjusted based on the original image size.

1.8.4.9 Pagination

Pagination

Pagination is a speed menu option for the crosstab component that allows you to choose Across then Down or Down then Across printing for the crosstab report.

1.8.4.10 ParentHeight

ParentHeight

ParentHeight is a speed menu option that allows you to set the shape of an object so that it matches the height of a band. Right-click over a component to select ParentHeight.

1.8.4.11 ParentWidth

ParentWidth

ParentWidth allows you to set the shape of an object so that it matches the width of a band. Right-click over a component to select ParentWidth.

1.8.4.12 Position

Position

Position is a speed menu dialog that allows you to change size of an object. Right-click over a component to access this dialog.

1.8.4.13 ReprintOnOverFlow

ReprintOnOverFlow

ReprintOnOverFlow is a speed menu option that applies to static components, or components that always print at the same height. These types of components are frequently used with stretchable components because they serve the purpose of a heading. If a memo prints onto several pages, the heading component should print with it. Set the heading component to ReprintOnOverFlow so it will print on each page.

1.8.4.14 Send to Back

Send to Back

Send to Back is frequently used with shapes. This speed menu option allows components to be moved to the background. If you want to use a shape as a background, use the Send to Back function.
ShiftRelativeTo

ShiftRelativeTo is a speed menu option available to the following components:

- Memo
- DBMemo
- RichText
- DBRichText
- Region

This option allows us to associate these components with one another so that one can print directly after another. To make this association, right-click over a component, select ShiftRelativeTo, and choose the component you want to print first from the drop-down list.

StretchWithParent

StretchWithParent allows the selected component to change size according to the change in height of the band in which it resides. Right-click over a component to access this option.

ShiftWithParent

ShiftWithParent allows a static component to print after a stretchable component. Right-click over a component to select ShiftWithParent.

Stretch

This menu option applies to stretchable components only. When Stretch is not selected, the component behaves just like a static component: it prints the same height each time, regardless of text. When Stretch is selected, the component adjusts according to the amount of printing text.

Style

Style is a speed menu option for the crosstab component that allows you to choose between Repeated Captions or Standard printing.

SuppressRepeatedValues

This speed menu option prevents repeated values from printing for DBText and DBCalc components.

Visible
This speed menu option determines the visibility of an object. To set the visibility of a component to False, right-click over it and deselect Visible.

1.8.5 Static VS. Stretchable

1.8.5.1 Stretchable

**stretchable**

Stretchable components print according to the amount of text they contain; therefore, the size changes depending upon their contents. A component is only stretchable if it can contain several lines of text. For example, the **Memo**, **DBMemo**, **RichText**, **DBRichText**, and **Region** components are all stretchable.

1.8.5.2 Static

**static components**

Static components always print at the same height: they do not stretch to accommodate the length of text. They do, however, adjust their width to fit long words if the **AutoSize** option is selected. The **label**, **DBText**, and **System Variable** are all static components.
1.9 Reference
1.9.1 Glossary

A

Advanced component palette
align
Align or Space toolbar
AutoSize

B

bands
BarCode
bounding box
BringToFront

C

canvas
components
Configure
CrossTab
CrossTab Designer
CrossTab Wizard

D

data
data-aware
database
database table
Data component palette
data module
data pipeline
data traversal
Data Tree
data workspace
DataView
DBBarCode
DBCalc
DBImage
DBMemo
DBRichText
DBText
design workspace
detail band
DisplayFormat
dock
Draw toolbar

E
Edit
Edit toolbar

F
fields
floating window
footer band
Format toolbar

G
group
group footer band
group header band
guides

H
header band
highlight

I

Image

J

K

Keep group together

L
Label
Label Template Wizard
Line
Lines

M
MailMerge
MaintainAspectRatio
Memo
Memo Editor

N
Nudge toolbar

O
orphan
overflow

P
Pagination
ParentHeight
ParentWidth
Position
preview screen
properties

Q
query
Query Designer
Query Wizard

R
Region
report
Report Designer
Report Tree
Report Wizard
ReprintOnOverFlow
RichText
RichText Editor
rulers

S
select
selection
selection handles
Selection Tool
Send to Back
Shape
shift-click
ShiftRelativeTo
ShiftWithParent
Size toolbar
sizing
sizing handles
speed menu
SQL
Standard component palette
Standard toolbar
Start new page
static
status bar
stretch
stretchable components
StretchWithParent
Style
SubReport
Summary band
SuppressRepeatedValues
System Variable

T

tabular

title band
title bar

U

V

Vertical
Variable
Visible

W

workbench

X

Y

Z
Index

- A -
  Adding Fields 7
  adding fields to reports 8
  Adjusting Layout 7
  Adjusting Query 7
  adjusting report layouts 8
  Adjusting Reports 7
  Advanced component palette 35
  Align or Space toolbar 36
  altering reports 8

- B -
  bands 40
  BarCode 47
  Bring to Front 50

- C -
  checkbox 47
  Configure 50
  CrossTab 46
  Crosstab Wizard 34

- D -
  Data component palette 36
  data pipeline 18
  Data Tree 36
  data workspace 13
  database 16
  DataView 17
  DBBarCode 48
  DBCalc 49
  DBImage 49
  DBMemo 49
  DBRichText 49
  DBText 49
  designing reports 8
  detail band 43
  Draw toolbar 37

- E -
  Edit menu option 50
  Edit toolbar 38
  exporting report templates 7

- F -
  Filtering reports 10
  Filters - Receiving 7
  footer band 44
  Format toolbar 39

- G -
  group footer band 44
  group header band 42

- H -
  header band 41
  help with report builder 12
  How To 7

- I -
  Image 47
  importing report templates 7

- L -
  Label 47
  Label Template Wizard 33
  Line 47
  lines menu option 50

- M -
  MaintainAspectRatio 51
  Memo 48
  More Help 7
- N -
Nudge toolbar 39

- P -
pagination 51
ParentHeight 51
ParentWidth 51
Position 51
Preview Workspace 15

- Q -
Query Designer 22
Query Wizard 18

- R -
Region 46
report - altering 8
Report Builder - Support 4
Report Builder - Tech Support 4
Report Designer 13
Report Tree 39
Report Wizard 27
reports - adding fields 8
reports - adjusting layout 8
reports - data 11
reports - designing 8
reports - exporting templates 7
reports - filters 10
reports - importing templates 7
reports - more help 12
reports - search 11
reports - searching 10
reports help 12
ReprintOnOverflow 51
RichText 48

- S -
searching in reports 11
searching reports 10
Send to Back 51

- T -
Tech Support - Report Builder 4
title band 46

- V -
Variable 48
Visible 52

Shape 48
ShiftRelativeTo 52
ShiftWithParent 52
SQL 18
Standard component palette 40
Standard toolbar 37
static 53
Stretch 52
StretchWithParent 52
SubReport 47
summary band 45
Support - Report Builder 4
SuppressRepeatedValues 52
System Variable 48